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Release Features 
My Vision Express is proud to announce a variety of new features in this release.  

The new and exciting features include the following:   

 

Calendar 
A system time clock - a new ticking, live clock will now display the time.  This will 

provide more clarity to users regarding the exact time and reflects based on the 

time zone of the location. 

 
 

A new button has been added to the Calendar called "Save/Update Note" to 

facilitate saving and updating Calendar notations.  This feature has been optimized 

so that multiple users in the office can utilize it simultaneously. Now, you can leave 

notes for the staff directly on different days in the Calendar. 

 
 

New logic was added to the Physician Setup to notify users who deactivate a 

Physician who has active appointments on the calendar.  This feature will hide that 

Physician's future appointments from the calendar, but will not cancel the 

appointments. 

 
 



 

Exam   
There is now a "Scribed by" field within the Assessment tab of the exam.  

 
 

A new button has been added to the Exam called "New Same Exam” Button. This 

new feature will allow the physician to create a new exam for the same patient 

without having to leave the Exam module. 

 
 

There have also been some Meaningful Use improvements and updates (Vitals tab, 

Immunizations tab, Allergy severity, etc.). 

 

 

 

 

 

 

 

 



 

A new sub-tab within the Refractive tab will now display the Spectacle Lens History 

of the patient for ease of prescription look up and re-ordering. 

 
 

Orders    
We have made some adjustments to the function of After Sales and how it interacts 

with the original and the newly created orders. You will also now be able to modify 

line items on a new order that was created via After Sales. 

 

Newly added is a new Order Search, located on the main toolbar. Entering an order 

number and clicking the ‘Search’ icon will display the order. Clicking ‘Search’ with no 

order number will automatically bring up an Orders Search window. 

 
 

You’ll also now find Order Dates displayed within your Payments window. 

 



 

Patient Profile  
Within the Appointments Tab of a Patient's Profile, Canceled appointments are 

highlighted red and Confirmed appointments are highlighted green to allow users 

to see appointment status with a glance. 

 
 

We’ve also added an "Auto Merge" feature in the Patient Merge tool to allow for 

easily merging of duplicate patient records.  This feature will identify patients with 

the same name, address, date of birth, and e-mail address added. 

 
 

The Canadian Health Card number has been added on the Search Patient, Search 

Exam and other windows to allow for better usability and search ability for clients 

located in Canada.  

 



 

Enhancements 
Enhancements included in the release. 

 

Calendar 
1. A line has been added that runs horizontally through the Calendar to indicate 

the current time. 

2. The "Resource Availability" has been added in the Calendar to allow for 

creating events for multiple physicians simultaneously: 

 
3. ‘Approve’ and ‘Deny’ options have been added to the Online Appointment 

Pending Request window:  

 
4. Services will no longer visible when the "Unavailable" radio button is selected 

when creating a new Resource Availability: 



 

  
5. Past dates on the calendar will now be appear greyed out: 

 
 

Customizer 
1. The option for adding "Tray Number" as a possible search option has been 

added in Customizer. 

2. A patient's nickname and cell phone number are available fields to add in 

Customizer for Spectacle Lenses and Contact Lens Order Types. 

 

 

 

 

 

 

 

 

 

 



 

Exam 
1. Doctor’s signature will now include a date and time stamp: 

 
2. Added a field for "serial number" for Immunizations. 

3. Observational Details will save when multiple row entries are entered in the 

Immunizations.  

4. "All" radio button is added to the Exam Interactions window to see all 

interactions pertaining to all exams. 

5. Allergy Severity:  

 
6. CCD is imported successfully and displays Reactions and Severity columns by 

clicking view button for imported CCD. 

7. The default browser for the RCP dashboard can be accessed by going to 

File>Reports>Meaningful Use and will direct users to log in with employee's 

user id. 

8. Added “Source Field” to Import CCD Windows. 

9. The ability for users to validate CCDs when being imported has been added. 

10. Made keyboard key directions pressed more intuitive in the Prism 

prescribing areas. 



 

11. Questions answered by patients on the Portal related to computer usage will 

transfer to the Questionnaire section of the Exam when imported into a 

Patient’s Profile. 

12. The category "Prescription Route" is changed to have the Medication Route 

FDA as a drop-down; users are also able to add more values. 

13. Vital Sign tab has new additional fields: 

 
14. Spectacle Order History tab: 

 
15. Notes field can now be copied from History:  

 



 

16. Reason(s) for Visit can now be prioritized: 

 
17. Problems List performance has been enhanced for better efficiency and 

speed. 

18. A new “Implantable tab” is added in-between cognitive and HL7 CCD tabs 

with Add, Delete, and Modify buttons. 

19. Added a "Detail" radio button in the exam that will allow Canadian users to 

see previous billed dates. (Canada) 

20. When a CCD is imported, fields are used for an incoming referral (referral, 

transition of care, or new patient). When a CCD is created these fields can be 

used to refer a patient to another physician. 

21. Added the ability to create CCD encounters in the RCP dashboard. 

 

Employee Messages 

1. Added functionality that will allow users to quickly open Exams, Patients, 

Order, and Insurance claims by double-clicking that field in an Employee 

Message. 

2. Users may now use the keyboard arrows to scroll through an Employee's 

Message. 

 

Insurance 
1. Added a feature to the Batch Payment window where orders of patients who 

are in collections will be highlighted yellow. 



 

 
2. Improved the ERA module to allow for multiple files to be imported 

simultaneously. 

3. The remittance file may be downloaded from MVE to any file in the user’s 

own folder.  

4. Added additional status options in the drop-down in the ERA Search Window. 

5. In the ERA module, the post status will automatically turn to "Unmatched" if 

no corresponding Order apply to facilitate posting. 

6. Printer Alignment options have been added to the Batch Print Claims Preview 

window. 

 

Integrations 
The "Print Setup" button has been removed from the "Barcode Labels" window and 

the printer selection is now arranged when selecting the "Labels" button. 

1. Improved speed performance for the "Import Gateway EDI" function. 

 

 

 

Inventory 
1. "Add Power" is now added to the "Measurements Tab" for all Spectacle Lens 

types. 

2. UPC field: 

 
3. When deactivating a frame, added a prompt that warns users if that UPC has 

open Order or Purchase Order. 



 

 
4. Notes entered onto the inventory frame details will now appear as a popup 

when selecting that frame in an order. 

 
5. When receiving POs in the Inventory, the "Update On Hand" feature has been 

optimized to be faster. 

6. Not On Claim: 

 
7. Item totals have been added to Inventory Receiving/Returns. 

8. A pause when clicking on "Details" for Spectacle Lens inventory has been 

eliminated. 

9. Pressing "Tab" in Inventory Receiving will now move to each field. 

 



 

Lens on Demand 
1.  “LOD Integration Setup” options have been upgraded and enhanced in 

Other Settings. 

 

Letters 
1. Search by appointment date and remove duplicate emails: 

 
2. Added "Header" and "Footer" buttons to the Letters Module to allow users to 

edit and utilize these parts of a Letter.   

 
3. Added "exam_diagnosis_and_procedures" to merge field to make diagnosis 

with pointers available in the Letters Module. 

4. Added merge fields to Letters for primary and secondary physicians' fax 

numbers. 

5. A "Custom List" feature has been added to the Letter's Module for Exam 

Letter type to facilitate printing multiple letters. 

6. Exam merge fields have been added to Exam Type letters: 

"patient_family_history" and "patient_family_history_inactive." 

7. "Exam_procedures" merge field now includes procedure codes. 

8. Search results for "addressline2" have been added for Letters. 

9. Outside prescription information is now available to be added to an exam 

type letter. 

10. All Secondary Physician details are now available merge fields for Exam type 

letters.  

11. A Tool Tip has been added when hovering over the checkbox "Exclude 

Patients with Scheduled Appointments" alerting the user of 

appointments created on or after the current date, they will be excluded. 



 

 
12. Created the "Health Card" merge field for the Letters Module and SSRS 

dataset. (Canada) 

 

Order 
1. Added the ability in Customizer to hide the Cost, Total Cost, and profit 

column from the Ordered Item List Screen. 

2. Added the field of "Patient Balance" to the Order Status Update screen. 

3. A save prompt will now appear when users select the "New Same" button in 

Order. 

4. A patient's full middle name will now be displayed in an Order. 

5. The order date for previous Order has been added to the Payment window. 

 
6. Multiple Selection options been added when selecting Modifiers. (Canada) 

7. Added a verification pop up message when changing the status of an order 

to "canceled." (Canada) 

8. Patients' e-mail addresses have been added to the Batch Statements order 

selection screen. 

9. The Company Logo will appear on the receipt printed directly from the order; 

it will also show on the copy printed from the Interactions tab. 



 

10. A message will now prompt users for all order types if attempting to fill any 

Rx that is not the newest. 

 

Patient Portal 
1. Added additional functions in direct messages, including adding multiple 

attachments and the ability to sort messages by date. 

 

Patient Profile 

1. The CMS 1500 "Signature on File" field has been moved to the Insurance tab.  

2. “CL Reorder” box has been added in the Patient Profile next to the Exam 

Recall. 

3. Added an additional qualifiers drop-down box for patient name in the Patient 

Profile. 

4. When adding new patients, the Country field will pre-populate with the 

location's country from the system settings. 

 
5. Improved the predictive text function in the Primary and Secondary Physician 

fields. 

6. Added a feature where a Patient's Profile will become "Inactive" when the 

profile is marked as "Deceased." 

7. Users are now able to view the body of a message in the Modify Interaction 

window of Patient Interactions. 

8. A prompt will now display when attempting to add an exam or order to a 

deceased patient. 

9. A Tool Tip has been added to the Patient Profile when hovering over the 

diagnosis code. The Tool Tip will now display a description of the code. 

10. Patient Files have been added allowing the insertion of files into multiple 

Patient Profiles, via the Document Manager within Tools>Maintenance.  



 

 
11. In the Patient Communications options window, the system will now flag you 

when approving text messaging for a patient who does not have a cell phone 

number in his/her profile. 

12. A new alert has been added for a patient's birthday.  An alert expiry can also 

be set for this alert. 

13. '"Race" and "Ethnicity" have been added as additional fields in the Patient 

Profile. 

14. Changes made to Portal Sync to save contact Method in interactions for 

Meaningful Use. 

15. The length of the middle name textbox has been increased and will now 

display the full name instead of the abbreviation. 

16. "Sexual Orientation” option has been added to the Patient Profile screen. 

17. Users may now sort data by clicking the header of "Age" and "Relationship" in 

the Family Tab in the Patient's Profile. 

18. The Patient Profile now shows Family Balance, Last Visit, and Next 

Appointment Scheduled fields. 

19. Physician column has been added to the HL7\CCD tab in Patient Profile. 

20. Added a new setting to Patient Communications options:  "Portal Information 

Provided" will show the timestamp of the most recent successful sync to the 

Portal. 

21. A Progress Bar was added to display the current loading progress of the 

patient list. 

22. The Provider field in the patient's details will display a popup when the 

required field is left blank. 

23. Full notes in the Patient Profile will display and the Tool Tip will also display 

the full note. 

24. Expired/Discontinued text on the top of greyed out column will display in the 

Vision Rx tab of the Patient Profile. 



 

25. Multiple order receipts can now be printed or e-mailed when in the Patient 

History of their profile. 

26. When a claim is printed, it is saved in the Patient Profile Interactions under 

Documents. 

 

Reports 
1. Added "Adjustments" report to the SSRS portal. 

2. "Lab Cost" managed by users on Order is now being reported on "Order 

Profit Report" and the "Lab Status" Reports in the SSRS Portal. 

3. Added Status, Check-in, and Check-out time to "Calendar Appointment" 

Report. 

4. Added a new SSRS report titled "Detailed Order Sales." 

5. "Item Cost" and "On Hand Cost" have been added to the SSRS Frames Sold 

Financial Report. 

6. The "Cost" column has been added to the Sold Financial Report. 

7. Denominator and Numerator have been added to the Core Meaningful Use 

Report for Objective #8 and #9 for 2015 Stage 2 Reports. 

8. Patient Aged Receivables Report has been modified to group by patient and 

display details of Order when the row is expanded. 

9. A new option "Exclude Order without a balance" has been added to the SSRS 

"Order by Employee" Report. 

10. "Logged in Employee" column has been added to the Order by Employee 

SSRS report.  This shows the employee who sold the order. 

11. The Physician Professional Services Productivity Report has added the 

Insurance company name.  

12. "Self-Pay" option will display on the "Sales Payer Report" if there is no 

insurance company for payments. 

13. The "Previous AR" verbiage has been updated to "Previous A/R Balance" with 

the date on multiple reports for clarity. 

14. New search criteria have been added for the "Lab Status" for the Lab Status 

Report. 

15. The Order by Employee Report will now display the date and time an order 

was created. 

 

Setup 
1. When importing a diagnosis code in the Diagnosis Setup, the eye is filled 

depending on the description having the following: “right eye”, “left eye”, or 

“bilateral”. 



 

2. Added additional settings under Other Settings>Inventory to allow users to 

set defaults for Pick Ticket Add items. 

3. Added "General" settings in the software for Employees and Insurance under 

"Other Settings" to allow users to quick add Employees and Insurance plans 

to a new location to make setting up a new location faster. 

4. "Expand All" and "Collapse All" buttons are now available in Security; one 

click into the security sections will expand/collapse all tree views. 

 
5. An Auto Maximization setting was created in other settings under Exam 

allowing a default option for the window size at launch. 

6. The first letter will not auto-capitalize when typing into the Social Media fields 

in the Other Settings area. 

7. Users will now have the capability of hiding Inventory options by deselecting 

them in the security settings: "Add To All", "Import", and “Import CSV" 

buttons are now available to be hidden. 

8. Added the option of "Health Card" an as available required field for Canadian 

users.  

 

Additional Enhancements 
A date filter is added for quicker retrieval and easier filtering when in interface 

exceptions and you may now re-access the Start Page screen after closing by 

selecting Start Page in the Help menu. Multiple three-state tick boxes have been 

added to the system in the Patient Communications, Patient Profile, Letters as well 

as other modules: A Checked box means ‘Yes’, a Filled box indicates ‘No’ and a blank 

box indicates ‘Not Asked/NA’. 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Bug Fixes  
 

Calendar 
1. Fixed a bug where calendar notes did not save when using the "Advance 

forward x Months" buttons. 

2. Fixed an issue in the outdated version of the Calendar where users were not 

able to use the Physician drop-down box without receiving an error. 

3. Fixed a bug where users received an error when attempting to print 

appointments from the Preview Tab on the Calendar. 

4. Fixed an issue where the view of the calendar was changing inadvertently 

when using the "Advance Forward x Days" button. 

5. Fixed a discrepancy in the calendar where hovering over an appointment 

displayed the incorrect appointment start and end times in the Tool Tip. 

6. Increased the sizing of the "Date of Birth" column in the Calendar Preview so 

that birthdates are more legible. 

7. Fixed an issue in the Calendar where notations were not able to be seen or 

modified by users logged into the Calendar simultaneously. 

8. Now, when adding a custom service, the Send to Lab and Appointment 

checkboxes will remain unchecked as originally intended. 

9. Added additional viewable space to the Calendar>Appointment Notes area. 

10. Fixed an issue where Resource Availability recurrence items were placed in 

unintended or unspecified places. 



 

11. The "Patient Tracker" will now remain on the selected patient after 

refreshing. 

12. The Insured party radio buttons is visible in the new patient created from the 

Calendar window. 

13. Monthly Availability Recurrence is working as intended. 

14. An error has been corrected when selecting physician below print preview in 

calendar. 

15. A fix was applied to the Patient Tracker to properly track the patient 

appointment history with correct timestamps. 

16. Fixed an issue in the Calendar where pre-appointment exams were being 

created irregularly. 

17. The preview view in Calendar will not show Rescheduled appointments 

without clicking on Reschedule check box. 

18. An issue has been addressed on the MVE Calendar to correctly sync with the 

Online Appointments Calendar. 

19. Available time slots will display as intended when rescheduling an 

appointment. 

20. The Patient Tracker will not change the check-in timestamp according when 

status changes occur on the Tracker. 

21. The "Health Card" field will now be showing in the calendar when creating 

new appointments as originally intended (Canada). 

22. The Canadian Health Card number will now display on the "Print Daily" of the 

Print Preview as originally intended (Canada). 

 

Customizer 
1. Added additional fields to the Customizer for additional edits on Contact 

Lens, Spectacle, and Hard Contact Lens Prescriptions. 

2. "Gender Type" has been added within Customizer for Frame Labels. 

3. Added multiple new fields to Patient Labels in the Customizer. 

4. Fixed an issue when editing "Spectacle Lens Material" field in the Customizer. 

5. Contact Lens Care field can now be added to the patient's prescription with 

Customizer. 

6. Added "Health Card Number" as an available Customizer field for Canadian 

users. (Canada) 

7. Added "Current Date" and "Health Card Number" as available options in 

Customizer. (Canada) 

 



 

Exam 
1. Fixed an issue where users could not specify their own Problem in the 

Problems List due to an issue with the ICD9/10 type. 

2. Fixed a bug where users could not use quotations in the Chief Complaint 

fields. 

3. Copying historical data from the External tab, Exam Method will now be 

copied as originally intended. 

4. The "Available" button in the Assessment Tab will now link to the proper ICD 

codes as intended. 

5. Hbase and Vbase may now be left blank when necessary. 

6. Test Type and Body Part fields are visible without scrolling.  

Locked exams will not allow the ability to modify entries.  Either a new exam 

or Addendum will need to be utilized. 

7. SNOMED codes will now auto populate to the master code registered in the 

Problem List window. 

8. Notes added to the Refraction tab will print entirely without being cut off as 

intended. 

9. Scroll bar for diagnosis and additional Lens Measurement Fields are 

functioning as intended. 

10. When the sort order for the "CD Ratio" is set to 10, the drop-down for "Horz" 

and "Vert" remain to function as intended. 

11. Adding new categories to the "Treatment Plan" will save as intended. 

12. The K-Graph OD Cycle Tab order is working as intended. 

13. On the Refractive tab in the Exam Module, fixed an issue where Cylinder did 

not auto-populate when using the OD=OS button under the keratometry 

reading. 

14. When adding and searching for problems in the Problem List, items will not 

be preselected as originally intended. 

15. On the Rx Pad in the Exam module, no additional windows or popups will 

load when opening this window. 

16. The prompt that usually appears when updating diagnoses will only appear 

when pressing "Save." 

17. Fixed an issue that occurs when trying to delete Immunization Records. 

18. The BMI will now properly calculate a percentage based of Height and Weight 

entered as intended. 

19. Exam alerts are now showing as intended. 

20. Fixed an issue for Canadian users who had duplicate procedures added to 

their exams unintentionally.  

 



 

Employee Messages 
1. In the Employee Messages Module, changed the verbiage of "Insurance #" to 

"Claim #." 

2. The deselecting "All Users" option has been corrected to uncheck users as 

intended. 

 

Insurance 
1. Fixed a bug in the fee schedule where custom items were copied to other 

plans when using the "Copy From" feature. 

2. Fixed an issue in the Auto-Generate claims area where items were being 

cleared from the searched criteria when using the "Header Filter" feature. 

3. Fixed an issue with boxes 9a-9d not printing properly in "Print Image" file 

when billing secondary insurance. 

4. Fixed a bug where manually added allocations using the "Details" button in 

the Batch Payment module were not properly saving. 

5. Fixed an issue where users were returning an error when attempting to load 

the Gateway Payer ID list when importing insurance plans. 

6. Fixed a bug where the claims were not properly applying tax as intended 

when "Add Tax to Claims" setting was turned on. 

7. Direct Messages will now be updated to the location's local time as originally 

intended. 

8. Fixed a bug where the ERA module was not properly loading the payment 

and copay amounts into the module. 

9. Fixed an issue in the ERA module where users were not able to post payment 

when the payment amount loaded in was $0.00, causing the users to have to 

erroneously write-off the claim. 

10. Alert displaying "billing as does not exist" has been corrected and will no 

longer appear. 

11. The "Patient Pays" formula is calculating as expected as per the formula in 

Insurance Fee Schedule from the Procedure Code specifics. 

12. The formula applied in the insurance fee schedule is applying correctly in an 

order. 

13. An issue has been addressed allowing rows to be deleted from a claim. 

14. Material Allowance amount is now shown as negative when entered in the 

Fee Schedule. 

15. Modifying a Procedure for claims only prompts the relevant codes. 

16. Referring provider tab and the Ordering provider information will now show 

when the options is checked for 'Ordering Provider' (box 17) in the Insurance 

Company. 



 

17. Validation errors have been corrected when submitting Medicare claims. 

18. Taxes will no longer apply when the "Include Tax in Claims" is unchecked in 

the Insurance Plans. 

19. VSP Advantage plan has been corrected and properly functions in the Fee 

Schedule. 

20. All Canadian insurances (except MSP) will now show errors before clicking 

"Create File."  

 

Integrations 
1. Fixed an issue where duplicate configuration were being added when 

importing contact lenses through the CLX integration. 

 

Inventory 

1. In the Receive Inventory transaction window, the Canceled and Canceled 

Reasons fields are now closer together to allow for better clarity. 

2. Fixed an issue where contact lenses configurations were not copying as 

intended. 

3. Fixed an issue where the Contact Lens Inventory Transaction screen was 

causing the application to freeze. 

4. Fixed an issue where UPCs could not be entered on the "Item Detail" screen 

without yielding an error. 

5. Fixed an issue in the Lens Treatments where the "duplicate" button was not 

duplicating procedure codes as originally intended. 

6. Fixed an error when users were returning an error when attempting to add 

spectacle lens inventory to all locations. 

7. Frame cost will now populate cost (if entered onto a frame item) when 

scanning UPCs in the Receiving module as intended. 

8. Fixed unintended errors when importing from the Master List for Frames. 

9. Fixed an error where users were not able to Add/Modify Contact Lens 

Inventory Items as intended. 

10. Loading Frames has been enhanced for faster speed performance. 

11. "Frame Total" now displays the accurate number of records as displayed on 

the list after filter is applied. 

12. Duplicate frames in the PO has been corrected when importing from 

FramesData IDA. 

13. All the required fields in Inventory will now display in red. 

14. An error when loading “L'amy America” manufacturer in FramesData IDA has 

been corrected. 



 

15. An imported Spectacle Lens item will not allow the lens type category to be 

deleted or blank. 

16. Speed performance has been improved when retrieving frames in Inventory 

Transactions. 

17. Users are no longer forced to use a "+" before Add Powers for multifocal 

Contact Lens configurations. 

18. The Configuration tab will match the location that is being selected in the 

inventory as intended. 

 

Lens On Demand 
1. A filter is now available in the LOD window to allow the user to filter by 

Suppliers. 

2. Added an error message to the LOD order to flag Physicians to link their NPI 

in the system settings to properly submit LOD Order. 

3. Order submitted through LOD will no longer generate an error. 

 

Letters 
1. Fixed a bug where adding a diagnosis on the Assessment Tab of an exam 

without specifying OD or OS caused a typo on the Letters Module. 

2. Users may now use the Letters Module to generate patient labels without 

encountering any error messages. 

3. The "patient_recall_date_long" will now display the full month rather than an 

abbreviated month name when used in the Letters module. 

4. Fixed a bug where contact lens inventory items were unable to be imported 

into an order as intended. 

5. In the Assessment tab, "Exam Recall Reason" the newly added reason is 

appearing without delay. 

6. Changes in spacing have been corrected between merge fields in the layout 

of an exam letter. 

7. PFSH merge fields are now working as intended in Exam Letters. 

 

Orders 
1. Now when processing a frame warranty (where no lenses are selected) in a 

spectacle lens order via After Sales, the new order type will default to "Frame 

Only" as intended. 

2. Fixed an issue where users could not exchange Soft Contact Lens Order 

multiple times via After Sales. 



 

3. Fixed a bug where the default reason was not showing in Warranty After 

Sales transactions. 

4. Modified the settings around After Sales to change the use and visibility of 

the "Return" button in an order to be more in line with current software user 

settings. 

5. Fixed an issue where users could change the status of a paid order to 

"Quote." 

6. Fixed an issue where the current date did not default for Manager Discount. 

7. In Receipt/Statement Notes, the note will now default for all locations when 

no location is selected. 

8. Finishing Center category no longer has duplicates as intended. 

9. When using an automated system such as Patient Communications, the 

application will no longer put a random employee's name as the notifying 

employee and will instead indicate the notification was automatic on the 

order. 

10. Fixed an issue for some users who were unable to delete or modify 

payments in the Checkout as intended. 

11. Due to a pricing issue for new Order in After Sales, items can now be 

amended manually to adjust prices in the new order. 

12. The inventory listing filter is now working as intended when selecting the 

frame ellipsis button. 

13. Fixed an issue in the Order window where item statuses were not displayed 

properly when shipping items from the CDC. 

14. Re-Importing frames via FramesData IDA will keep existing retail price 

without change. 

15. Printing a Spectacle Lens order receipt will not generate a blank page to 

print. 

16. Same marketing amounts are now being applied for different spheres. 

17. Order in "Quote" status will automatically clear when the payment button is 

selected. 

18. Fixed a bug where users could delete an Order status fixed by other users. 

19. Processed items in an order are now unable to be deleted as originally 

intended. 

20. The "Your Savings" field will now hide from a patient's receipt when savings 

equals zero. 

21. Modifying an order will not will not reset the originally entered Promise Date. 

22. Service items will not be returned when conducting an exchange in the After 

Sales Wizard. 

23. Taxes will not be written off when adding BOGO marketing code to an order. 



 

24. Order can be modified without generating an error as intended. 

25. Printing prescriptions from the Refractive tab in the Exam and/or the Vision 

Rx tab from the Patient Profile will print from the correct location as 

intended. 

26. Fixed an error where notes could not be saved in a Soft Contact Lens 

order(Canada). 

 

Patient Profile 
1. A CL Reorder box has been added in the Patient Profile next to the Exam 

Recall. 

2. Fixed a bug where users were unable to successfully copy/paste phone 

numbers onto a Patient's Profile. 

3. Fixed a bug where defaulted Communications settings were not applying 

properly for new patients added via the Calendar. 

4. In the Patient Profile Consent tab, the Replace File buttons will now work as 

intended. 

5. The Entered Date in a Patient's Profile will no longer update when altering a 

patient's information from the Calendar. 

6. An issue has been correcting when deleting entries from the HL7/CCD 

subtab. Only the selected file will delete. 

7. "Order by Item" date range is now showing correctly in the header.  

8. Database is not locking when accessing the Patient Tracker. 

9. An issue has been corrected when printing a patient's prescription causing 

unresponsiveness. 

10. Fixed an unresponsiveness issue when accessing Inventory for Spectacle and 

Contact Lenses. 

11. Printing statement receipts will include the notes added in setup when done 

for all locations as intended. 

12. When the "Recall From" is changed, now all corresponding "Exam Recall" and 

"Follow Up Recall Date" are updated to match. 

13. The alert verbiage has been corrected allowing for more clarity regarding 

entering an "Invalid Date" in the Refractive tab of the Exam. 

 

Reports 
1. Repaired the "Order Breakdown Report" in SSRS to properly print and export 

as intended. 

2. Added clarity to the date search criteria on the SSRS "After Sales Transaction 

Report." 



 

3. Fixed a discrepancy in the calculation of the 120+ balance on the SSRS Aged 

Receivable reports. 

4. Renamed the Audit table of Patient Medications to "Prescriptions" for clarity. 

5. The "Calendar Productivity" SSRS report will no longer report on cancelled or 

no-show appointments. 

6. The SSRS Report "Product Activity by Payer" now runs as intended. 

7. Fixed an issue with tax calculations on the SSRS "Day Sheet" Report. 

8. Fixed an issue in the Daily Closing where EFT is still showing when turned off 

in the settings. 

9. The Employee field in the SSRS Marketing Report is now showing the 

employee information as intended. 

10. Fixed an issue for the users who were unable to run the SSRS "Day Sheet" 

report without errors. 

11. Users can run the MVE Frame Inventory Report as intended. 

12. "Frame On-Hand Count Reports" now correctly display inventory counts. 

13. "Insurance Balance" in Insurance Claim Status Report is reporting as 

intended. 

14. Frames Sold Report is no longer including Patient Own Frames when 

counting "On Hand Tracked" inventory.  

15. The “Order by Item Type” reports will now only report the 

physicians selected. 

16. EFT payments are included in the Aged Receivable section of the Day 

Sheet report. 

17. The total payment amount in the "Payments" Report and "Day Sheet" Report 

are same in SSRS. 

18. Physicians Sales by Department Report calculation was corrected for total 

payment amount. 

19. Professional Services Demographics Report has been corrected and is 

displaying data successfully. 

20. Calendar Productivity report now excludes No shows, Rescheduled, and 

Canceled appointments. 

21. The location logo and address is displaying the same in Rx print-out, even 

when the patient is created at another location. 

22. Aged Receivables and Calendar Appointments Per Day Reports are operating 

as intended. 

23. A correction has been applied to remove erroneous Aged Receivables 

balances due to penny rounding. 

24. Correct totals have been adjusted in the Day Sheet for "Total Cash Check 

Other." 



 

25. The commissions will be allocated to the employee who sold the order as 

intended. 

26. Errors with Taxes 1 and 2 in the Day Sheet Report in SSRS have been 

corrected. 

 

Setup 
1. Fixed a bug in the security settings where the "Exchange" and "Reprocess" 

buttons could not be properly hidden in the After Sales window.  

2. Increased the character limit of Category items. 

3. Changes made to Employee setup will be saved right away so users do not 

have to continually press "save." 

4. Added additional "Clipboard" categories to File>Setup>Categories. 

5. When deleting a location, now employees of that location will be deactivated 

instead of deleted. 

6. Fixed an issue where users were returning an error when accessing the 

Location Tab in the Company Setup. 

7. Scrolling the Notes detailed field using down and up arrows will not change 

corresponding employee in the Employee Setup screen. 

8. Removed the "taxonomy" field from Physician Setup for Canadian Users. 

(Canada) 

9. Enabling "Accept Communications Default" set to Yes (File > Setup > System > 

Other Settings > Communications > Patient), all options in the "Commun..." 

for the patient will be automatically enabled when a new patient is created or 

imported. 

 

Additional Bug Fixes  
1. Fixed an error upon launching the Patient Profile for users who use a 

dd/mm/yyyy format. 

2. Updating retail prices can now be done in bulk for Contact Lenses. 

3. The "Spectacle Lens Range" now has a horizontal scroll bar. 

4. Fixed a bug where an error was returning when creating audit triggers.  

5. An upgrade error was addressed when upgrading from within the 

application. 

6. Full window is printed when a Print Screen function is selected with MVE.  

An issue has been addressed where the worked hours would be .01 to .02 off 

the working hours when entering TimeOut on the Time Clock.  

7. Deactivated frames will not appear in the Frame Inventory after closing the 

Reactivate window with no frames selected.  All master import lists now have 

a progress bar instead of a popup when syncing data. 



 

8. Fixed a bug where users could not use the time clock when logging into a 

location in a different time zone. 

9. Fixed an issue where users could not properly use the Order Screen when 

opening a Patient Profile from the Patient Tracker directly.  

10. In the Patient Search, "All" is now the defaulted value for status. Removed an 

unintentional dotted line from the Company Setup screen. Users may now 

export/save multiple receipts and statements simultaneously. 

 


